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About this Document

This document covers the RS9113 Module’s Evaluation Board (EVB) and its usage for
evaluating Redpine Signals’ RS9113 based ultra-low-power, single spatial stream,
dual-band 802.11n + BT4.0 + ZigBee Convergence modules in n-Link® and
WiSeConnect® modes.
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1 Overview

The RS9113 Module Evaluation Kit (EVK) is a platform for evaluating the
RS9113 modules with multiple Host Processors/MCUs over interfaces like
SDIO, USB, USB-CDC, SPI and UART. The EVK includes sample driver,
supplicant, applications to test the following:

1) Wireless Functionality for Wi-Fi, BT 4.0 and Zigbee
2) Security modes

3) Throughputs

4) Power Consumption

5) Firmware Upgrade

The RS9113 n-Link®, WiSeConnect® module families are based on
Redpine Signals' RS9113 ultra-low-power, single spatial stream, dual-
band 802.11n + BT4.0 + ZigBee Convergence SoC. The RS9113 module
integrates a multi-threaded MAC processor with integrated analog
peripherals and support for digital peripherals, baseband digital signal
processor, analog front-end, crystal oscillator, calibration OTP memory,
dual-band RF transceiver, dual-band high-power amplifiers, baluns,
diplexers, diversity switch and Quad-SPI Flash thus providing a fully-
integrated solution for embedded wireless applications.
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2 Evaluation Kit Contents

The RS9113 Module Evaluation Kit comes with the following components:
1) RS9113 Module Evaluation Board

2) USB Pen drive

3) USB-to-microUSB Cable

4) SDIO Adaptor Cable

5) SPI Adaptor Cable
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Figure 1: Evaluation Kit Contents

The USB drive is bootable. It is loaded with Fedora Core 18 OS with the
OneBox-Mobile driver binaries included for evaluation of n-Link® modules
on a standard PC/Laptop platform.

The USB drive also has the release package for the Connect-io-
n®/WiSeConnect® modules which includes the firmware, documentation
and reference projects for multiple platforms.
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Redpine provides drivers for multiple OS’s and MCU platforms for the n-
Link® modules and also OS-less MCU platforms for WiSeConnect®
modules. The software provided in this kit is to enable easy and quick
evaluation on a PC. Please contact Redpine Signals’ Sales
(sales@redpinesignals.com) for availability of drivers for an OS and MCU
of your choice.
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3 Hardware Details

This section describes the RS9113 EVB’s various components and
headers.

The OneBox-Mobile software for the n-Link® modules supports SDIO and
USB interfaces to connect to the Host MCU. The OneBox-Embedded
software for the WiSeConnect® modules supports UART, SPI, USB and
USB-CDC interfaces to connect to the Host MCU.

As shown in the image below, the RS9113 EVB has three USB connectors
for the USB, USB-CDC and UART connections. The UART signals of the
module are converted to USB using on-board circuit. The board also has
SDIO and SPI Headers.

LEDs for Interfaces
(Left to Right: UART, USB, USB-CDC,
SPI, SDIO)

.........
-----

SDIO G—-REHiE: B 14 | R$9113 Module

SPI Gt B :nga

o RS9113 Evaluation
USB_CD!

Board

Current
Measurement

uUsB USB-CDC UART

Figure 2: RS9113 EVB

The board is designed to configure the module to use the interface on
which power supply is detected. This is indicated through the LEDs
mounted on the board. The SDIO and SPI interfaces require power supply
to be provided over the USB connector. Hence, for these interfaces, it is
required that the USB connection be provided first followed by the SDIO
or SPI connection.
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Follow the steps below to use the EVB with different interfaces:
1) USB, UART, USB-CDC Modes

a. Connect the USB-to-microUSB cable between a USB port of a
PC/Laptop and the micro-USB port labeled USB, UART or USB-
CDC on the EVB.

b. Verify that the LED labeled “"USB”, "UART" or "USB-CDC" lights
up as per the port which is connected.

2) SDIO Mode

a. Connect the USB-to-microUSB cable between a USB port of a
PC/Laptop and the micro-USB port labeled USB on the EVB -
this connection will be used only as a power supply in this
mode.

b. Connect the 10-pin header of the SDIO Adaptor Cable to the
EVB. Insert the SDIO Adaptor into the SDIO slot of the

PC/Laptop.
c. Verify that the LED labeled “SDIO” lights up.
3) SPI Mode

a. Connect the USB-to-microUSB cable between a USB port of a
PC/Laptop and the micro-USB port labeled USB on the EVB -
this connection will be used only as a power supply in this
mode.

b. Connect the 10-pin header of the SPI Adaptor Cable to the
EVB. Connect the other wires of this connector to the SPI
signals of a Host MCU platform. The details of the Header are
given in Appendix A.

There is a 2-pin inline jumper available for measuring the current being
sourced by the module during different stages of operation. This is
labeled as "MEASURE" on the PCB. The user may connect a power meter
or an ammeter to this jumper to measure the current.

To proceed further, click on the links below as per your requirement.

1) Evaluation of n-Link® modules

2) Evaluation of WiSeConnect® modules

Redpine Signals, Inc. Proprietary and Confidential Page 13



RS9113 Module Evaluation Kit -)) REDPINE®
User Guide A QSIGNALS
Version 2.0 DRIVING WIRELESS COMVERGENCE

4 Evaluation of n-Link®

This section covers the evaluation of the n-Link® mode of the EVK using
the OneBox-Mobile drivers in the following modes:

1) Wi-Fi
a. Client
b. Access Point
c. Wi-Fi Direct
2) Wi-Fi Client and Bluetooth Classic
3) Wi-Fi Client and Bluetooth Low Energy
4) Wi-Fi Client and Zigbee
The n-Link modules support SDIO and USB as the host interfaces.

4.1 Required Setup

¢ RS9113 EVK

e PC/Laptop to program the RS9113 EVB over SDIO or USB

e For evaluation of the Wi-Fi Client mode, you will require:
o Wi-Fi Access Point
o A second PC/Laptop with Ethernet

e For evaluation of the Wi-Fi Access Point mode, you will require:
o A second PC/Laptop with Wi-Fi

e For evaluation of the Wi-Fi Direct mode, you will require:

o A device with Wi-Fi Direct capability like an Android 4.0
smartphone or a Laptop

e For evaluation of the Bluetooth Classic mode, you will require a
device like a smartphone or Laptop with Bluetooth capability

e For evaluation of the Zigbee mode, you will require a Zigbee
Coordinator and Zigbee-enabled Light bulb which support the
Home Automation Profile.

NOTE: The procedure explained below is common across the USB and
SDIO interfaces. Please replace “<interface>" with "“USB” or "SDIO"” as
per your choice.

4.2 Getting Started
Please follow the steps below to get started with the evaluation process.

1) Plug the USB drive provided in the EVK and turn on the host PC.
Interrupt the PC from booting in normal mode (default) by pressing
‘F12’ key you can see the boot menu option, from there, select the
boot device as USB storage device and click Enter.

Redpine Signals, Inc. Proprietary and Confidential Page 14



RS9113 Module Evaluation Kit .)) REDPlnE®
User Guide A QSIGNALS
Version 2.0 DRIVING WIRELESS COMVERGENCE

NOTE: If you have a Windows 8 or later PC, the booting process might
fail because of the new UEFI mode (instead of BIOS) being used in such
PCs. Disable the UEFI Boot mode (enable CSM boot mode) and Secure
Bootup mode to boot from the USB drive on such PCs. Please follow the
steps listed in Appendix D.

Once these changes are done, the original Windows 8 OS will not be
bootable till the changes are reverted.

2) You will be presented a menu with the following options:
a. Start RS9113
b. Troubleshooting
Select “Start RS9113” and click Enter.

NOTE: In some PCs the bootup might fail because of Graphics
hardware incompatibility with the Fedora Core 18 OS loaded on the
USB drive. The screen will go blank rather than showing the booting
process. In such cases, select “Troubleshooting” then attempt to boot
in the Basic Graphics Mode.

3) Wait until the booting up completes and you get the Linux screen.

4) Press “Alt+F2"” and enter “"gnome-terminal” in the pop-up window to
open a terminal window.

5) Enter into super user mode using the “su” command in the terminal.
Enter “redpine” as the password when prompted.

6) Follow the steps below to use the EVB with different interfaces:
a. USB Mode

i. Connect the USB-to-microUSB cable between a USB
port of a PC/Laptop and the micro-USB port labeled
USB, UART or USB-CDC on the EVB.

ii. Verify that the LED labeled “USB”, "UART" or “"USB-
CDC” lights up as per the port which is connected.

b. SDIO Mode

i. Connect the USB-to-microUSB cable between a USB
port of a PC/Laptop and the micro-USB port labeled
USB on the EVB - this connection will be used only as a
power supply in this mode.

ii. Connect the 10-pin header of the SDIO Adaptor Cable
to the EVB. Insert the SDIO Adaptor into the SDIO slot
of the PC/Laptop.

iii. Verify that the LED labeled “SDIO” lights up.

7) Go to the /home/OneBox-Mobile folder and follow the instructions
listed in the sub-sections below.

8) To proceed further, click on one of the links below as per your choice.
a. OneBox-Mobile in Wi-Fi Only Mode
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b. OneBox-Mobile in Wi-Fi + Bluetooth Classic Mode
c. OneBox-Mobile in Wi-Fi + Bluetooth LE Mode
d. OneBox-Mobile in Wi-Fi + Bluetooth Zigbee Mode

4.3 OneBox-Mobile in Wi-Fi Only Mode

1) Open the common_insert.sh file present in */home/OneBox-
Mobile/<interface>" using the gvim editor.

2) Ensure that the DRIVER_MODE and COEX_MODE as set as below
a. DRIVER_MODE =1
b. COEX_MODE =1

NOTE: For SDIO mode, ensure that the SDIO stack related modules are
already inserted in the kernel. Follow the steps below for this:

# cd /home/OneBox-Mobile/SDIO
# sh load stack.sh
# lsmod

Verify that the output of the “Ismod” command lists the sdhci.ko,
sdhci_pci.ko, mmc_block.ko and mmc_core.ko modules. This is a one-
time process and need not be repeated unless the modules are explicitly
removed by the user.

4.3.1 Installation in Wi-Fi Client Mode

1) Edit the “sta_settings.conf” file in the /home/OneBox-
Mobile/<interface> folder using gvim and enter the parameters of the
Wi-Fi network as below.

a. For Open (non-Secure) mode
network={

ss51d="<SSID of Access Point>"
key mgmt=NONE

}

b. For Open (non-Secure) mode connection to a Hidden SSID
network={

$81d="<SSID of Access Point>"

scan_ssid=1

key mgmt=NONE

}

c. For WEP-64 mode

network={
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ssid="<SSID of Access Point>”"

key mgmt=NONE

wep_key0=XXXXXXXXXX

wep tx keyidx=X

}

The key can be input either in ASCII or Hexadecimal formats:
ASCII Format: wep key0=712345"

Hexadecimal Format: wep key0=1234567890

d. For WEP-128 mode

network={

$s1d="<SSID of Access Point>"

key mgmt=NONE

wep keyO= XXXXXXXXXXXXXXXXXXKXXXXXXX

wep tx keyidx=X

}

The key can be input either in ASCII or Hexadecimal formats:
ASCII Format: wep key0=71234567890123"

Hexadecimal Format: wep key0=12345678901234567890123456

e. For WPA-PSK (TKIP) mode

network={

ss51d="<SSID of Access Point>"

key mgmt=WPA-PSK

psk=<passphrase specified in the Access Point>
proto=WPA

pairwise=TKIP

group=TKIP

}

f. For WPA2-PSK (CCMP) mode

network={

ssid="<SSID of Access Point>”"

key mgmt=WPA-PSK

psk=<passphrase specified in the Access Point>

proto=WPA2
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pairwise=CCMP
group=CCMP
}

2) Next, run the “start_sta.sh” script in the /home/OneBox-
Mobile/<interface> folder to load the driver modules and the
supplicant and connect to the Access Point specified in the
“sta_settings.conf” file.

# sh start sta.sh

3) After issuing the above command a virtual interface with the name
“wifi0” will be created. You can view the list of interfaces using the
following command:

# ifconfig -a

4) You can check whether the connection to the Access Point is
successful by running the following command:

# iwconfig wifio

This command gives the status of the device. If the connection is
successful, then the connected Access point SSID along with the MAC
address is displayed. If it is not connected to an Access point a
message “Not Associated” appears.

5) To view the list of Access Points scanned in each channel, you can run
the following command in the /home/OneBox-Mobile/<interface>
folder.

# ./wpa _cli -i wifi0 scan_results

6) To obtain an IP address using DHCP, start the DHCP client using the
command below.

# dhclient wifiO
4.3.2 Installation in Access Point Mode

The “start_ap.sh” script present in the /home/OneBox-Mobile/<interface>
folder needs to be run with the different configuration files provided in
the same folder to install an Access Poiint in different security modes.

# cd /home/OneBox-Mobile/<interface>
# sh start ap.sh <conf file>
The different configuration files (conf_file) provided are as follows:
1) Access Point in Open Mode
a. Configuration File: wpa_supplicant_open.conf
b. This starts an Access Point with the following parameters:
i. SSID: REDPINE_AP
ii. Channel 1 of 2.4GHz Band (2412 MHz)

iii. Open (non-Secure) mode
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2) Access Point in WEP-64 Mode

a. Configuration File: wpa_supplicant_wep64.conf

b. This starts an Access Point with the following parameters:

i. SSID: onebox_wep
ii. Channel 1 of 2.4GHz Band (2412 MHz)
iii. Security Mode: WEP-64
iv. WEP Key: 1234567890
v. Key Index: 0
3) Access Point in WEP-128 Mode

a. Configuration File: wpa_supplicant_wep64.conf

b. This starts an Access Point with the following parameters:

i. SSID: onebox_wep
ii. Channel 1 of 2.4GHz Band (2412 MHz)
iii. Security Mode: WEP-128
iv. WEP Key: 12345678901234567890123456
v. Key Index: 0
4) Access Point in WPA-PSK (TKIP) Mode

a. Configuration File: wpa_supplicant_tkip.conf

b. This starts an Access Point with the following parameters:

i. SSID: onebox_tkip
ii. Channel 1 of 2.4GHz Band (2412 MHz)
iii. Security Mode: WPA-PSK (TKIP)
iv. Passphrase: "12345678"
5) Access Point in WPA2-PSK (CCMP) Mode

a. Configuration File: wpa_supplicant_ccmp.conf

b. This starts an Access Point with the following parameters:

i. SSID: onebox_ccmp

ii. Channel 1 of 2.4GHz Band (2412 MHz)
iii. Security Mode: WPA2-PSK (CCMP)
iv. Passphrase: “12345678"

NOTE: All the above parameters can be modified in the respective
configuration files by the user. The values provided are only for
reference.
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After running the “start_ap.sh” script a virtual interface with the name
“wifi0” will be created. You can view the list of interfaces using the
following command:

# ifconfig -a

You can check whether the Access Point has been started successfully by
running the following command:

# iwconfig wifiO

This command gives the status of the device. It displays the Access
Point’s SSID along with the MAC address and channel frequency. If the

Access Point doesn’t start, a message saying “Exiting: Driver Initialization
not completed even after waiting for xxms” is displayed.

To start a DHCP server, use the commands below.
# sh dhcp server.sh
# dhcpd wifi0 start

4.3.3 Installation in Wi-Fi Direct Mode

The “start_p2p.sh” script present in the /home/OneBox-
Mobile/<interface> folder needs to be run to start the supplicant and
install the Wi-Fi Direct mode. The configurable parameters in the
p2p.conf file are the listen channel, operating channel and GO Intent.
After starting the supplicant the p2p_commands mentioned below should
be executed.

1) To find other P2P networks

# ./wpa cli -i wifiO p2p find

2) To find other P2P devices in range
# ./wpa cli -i wifiO p2p peers
3) To connect to a P2P network

# ./wpa cli -i wifiO p2p connect <BSS ID> pbc
go_intent=<intent value>

4.3.4 Checking Throughputs

You can check the Transmit and Receive throughputs in UDP and TCP
modes by using the iperf application. If you wish to evaluate the
throughputs in Wi-Fi Client mode, you will need to connect a second
PC/Laptop to the Access Point. Download and install the iperf application
from https://iperf.fr/ on the second PC/Laptop.

Please note the following points for this evaluation:

1) To evaluate the module for throughput performance, it’'s
recommended that you connect the second PC/Laptop to the Access
Point over Ethernet.

2) It is recommended that you choose a Wi-Fi channel which has less
interference, preferably in the 5GHz band if the EVK is for a Dual band
module, to observe optimal throughputs of the module.
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3) Wireless throughputs vary with the environment of the test setup -
distance, obstacles, type of obstacles, etc.

4) The throughputs are also dependent on whether all the Wi-Fi
components in the test support 40MHz and 20MHz or only 20MHz
bandwidths.

To check Transmit throughputs, first run the command below on the 2"
PC/Laptop:

# iperf -s <-u> -1 1
This command starts an iperf Server which is listening for data. It prints
the received throughput at an interval of 1 second. The <-u> in the

above command is for UDP traffic. If it is not mentioned, then the traffic
is TCP.

Next, run the command below on the PC/Laptop connected to the EVB.

# iperf -c <IP address of 2md PC> <-u> -1 1 -b 100m -t 120

This command starts an iperf Client which starts transmitting data to the
Server.

To check Receive throughputs, run the Server command first on the
PC/Laptop connected to the EVB, followed by the client command on the
2"d PC/Laptop.

4.4 OneBox-Mobile in Wi-Fi + Bluetooth Classic Coexistence
Mode

This section describes the installation of WiFi and BT Classic modes. Note
that to use the Coexistence mode, each protocol should be loaded
individually one after the other.

1) Open the common_insert.sh file present in */home/OneBox-
Mobile/<interface>" using the gvim editor.

2) Ensure that the DRIVER_MODE and COEX_MODE as set as below
a. DRIVER_MODE =1
b. COEX_MODE = 2

NOTE: For SDIO mode, ensure that the SDIO stack related modules are
already inserted in the kernel. Follow the steps below for this:

# cd /home/OneBox-Mobile/SDIO
# sh load stack.sh
# lsmod

Verify that the output of the “Ismod” command lists the sdhci.ko,
sdhci_pci.ko, mmc_block.ko and mmc_core.ko modules. This is a one-
time process and need not be repeated unless the modules are explicitly
removed by the user.

3) Follow the instructions in Section 4.3.1, to install the Wi-Fi Client
mode.
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4) Run the “bt_insert.sh” script present in the /home/OneBox-
Mobile/<interface> folder to start the Bluetooth Classic mode. This
script inserts Bluetooth modules and common HAL modules if not
already inserted.

5) You can check whether the BT Classic mode has been started
successfully by running the following command:

# hciconfig

If the driver is loaded correctly, the above command displays a
network adaptor named “hciX”. An example output if given below:

hciO: Type: BR/EDR Bus: SDIO

BD Address: 00:23:A7:00:05:68 ACL MTU: 1021:8 SCO MTU:
30:8

UP RUNNING PSCAN
RX bytes:478 acl:0 sco:0 events:20 errors:0

TX bytes:331 acl:0 sco:0 commands:19 errors:0

6) After the device is up, we can pair with other devices or from other
devices using the Bluetooth Manager application. Files can also be
sent and received using Bluetooth Manager. Instead of Bluetooth
Manager, the device can be configured using “hcitool” or “hciconfig”.
The procedure for using Bluetooth Manager is explained in Appendix
B.

4.5 OneBox-Mobile in Wi-Fi + Bluetooth LE Coexistence Mode

This section describes the installation of WiFi and Bluetooth LE (BLE)
modes. Note that to use the Coexistence mode, each protocol should be
loaded individually one after the other.

1) Open the common_insert.sh file present in */home/OneBox-
Mobile/<interface>" using the gvim editor.

2) Ensure that the DRIVER_MODE and COEX_MODE as set as below
a. DRIVER_MODE =1
b. COEX_MODE = 4

NOTE: For SDIO mode, ensure that the SDIO stack related modules are
already inserted in the kernel. Follow the steps below for this:

# cd /home/OneBox-Mobile/SDIO
# sh load stack.sh
# lsmod

Verify that the output of the “lsmod” command lists the sdhci.ko,
sdhci_pci.ko, mmc_block.ko and mmc_core.ko modules. This is a one-
time process and need not be repeated unless the modules are explicitly
removed by the user.

3) Follow the instructions in Section 4.3.1, to install the Wi-Fi Client
mode.
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4) Run the “bt_insert.sh” script present in the /home/OneBox-
Mobile/<interface> folder to start the Bluetooth Classic mode. This
script inserts Bluetooth modules and common HAL modules if not
already inserted.

5) You can check whether the BLE mode has been started successfully
by running the following command:

# hciconfig

If the driver is loaded correctly, the above command displays a
network adaptor named “hciX”. An example output if given below:

hciO: Type: BR/EDR Bus: SDIO

BD Address: 00:23:A7:00:05:68 ACL MTU: 1021:8 SCO MTU:
30:8

UP RUNNING PSCAN
RX bytes:478 acl:0 sco:0 events:20 errors:0

TX bytes:331 acl:0 sco:0 commands:19 errors:0

6) After the device is up, we can Advertise, Scan and Connect with other
BLE devices. The device can be configured using hcitool or hciconfig.

4.6 OneBox-Mobile in Wi-Fi + Zigbee Coexistence Mode

This section describes the installation of WiFi and Zigbee (ZB) modes.
Note that to use the Coexistence mode, each protocol should be loaded
individually one after the other.

1) Open the common_insert.sh file present in */home/OneBox-
Mobile/<interface>" using the gvim editor.

2) Ensure that the DRIVER_MODE and COEX_MODE as set as below
a. DRIVER_MODE =1
b. COEX_MODE =3

NOTE: For SDIO mode, ensure that the SDIO stack related modules are
already inserted in the kernel. Follow the steps below for this:

# cd /home/OneBox-Mobile/SDIO
# sh load stack.sh
# lsmod

Verify that the output of the “Ismod” command lists the sdhci.ko,
sdhci_pci.ko, mmc_block.ko and mmc_core.ko modules. This is a one-
time process and need not be repeated unless the modules are explicitly
removed by the user.

3) Follow the instructions in Section 4.3.1, to install the Wi-Fi Client
mode.

4) Run the “zigb_insert.sh” script present in the /home/OneBox-
Mobile/<interface> folder to start the Zigbee mode. This script inserts
Zigbee modules and common HAL modules if not already inserted.
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5) You can check whether the Zigbee mode has been started successfully
by running the following command:

# ifconfig -a

If the driver is loaded correctly, the above command displays a
network adapter named “zigb0”.

4.6.1 Building and Running the Sample Home Automation Switch
Application

To help evaluate the ZigBee mode, a sample Home Automation switch
application is made available with the release. You will need a 3™ party
Zigbee Coordinator and Zigbee-enabled Light bulb which support the
Home Automation Profile. Ensure that the Coordinator and Light bulb are
switched on and connected before proceeding further.

4.6.1.1 About the Sample Application

This is the ZigBee Home Automation-defined switch application using
Host APIs. This application connects to the light parent and tries to match
the simple descriptors by using MatchDescriptor command.

After exchanging the simple descriptors, it will send the toggle command
to the light continuously.

4.6.1.2 Host API Folder Structure

The folder structure for host API along with sample applications has been
given bellow. This folder structure is available in /home/OneBox-
Mobile/<interface>/utils_zigbee

#. utils
build
core
hal
intf
ref_apps

The folders in the host_api folder are as follows:

1) build - contains the application’s compilation files

2) core - contains the host mode API implementation

3) hal - contains code related to the hardware abstraction layer

4) intf - contains code related to interface-dependent sections

5) ref_apps - contains the reference HA switch application
4.6.1.3 Application State Machine

The sample application architecture is based on a state machine. Please
refer to the app_stateMachine.h file for the defined states and the events.

The important sates in the state machine are as follows:
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1) STATE_STACK_NOT_READY - Stack is not initialized

2) STATE_NO_NETWORK - Stack is initialized but not joined any
network or formed a network

3) STATE_SCAN_ACTIVE_COMPLETE - Active scan is compete and ready
to join the network

4) STATE_NETWORK_JOINED - Joined the network
4.6.1.4 State Callbacks

The application callbacks that are called by the stack are provided in the
file app_callbacks.c which is present in the ./ref_apps/src folder.

The callback functions that are available in the app_callbacks.c are given
bellow.

1) AppScanCompleteHandler()

2) AppEnergyScanResultHandler()

3) AppNetworkFoundHandler()

4) AppZigBeeStackStatusHandler()

5) AppIncomingManyToOneRouteRequestHandler()
6) AppHandleDatalndication()

7) AppHandleDataConfirmation()

8) AppcChildloinHandler()

NOTE: The application developer should not call any of the APIs that send
command/data to the device from any of these callbacks.

4.6.1.5 Building and Running the Home Automation Sample Application
1) Go to the folder /home/OneBox-Mobile/<interface>/utils_zigbee/build
2) Clean the existing builds by giving the following command

# make clean

3) Build the Home Automation Switch application using the following
command

# make switch
4) run the switch app by giving following command
# ./switch

4.7 Driver Uninstallation Procedure

The driver can be uninstalled along with the different modules using the
scripts provided in the /home/OneBox-Mobile/<interface> folder.

1) remove_all.sh: Uninstalls the complete driver and all modules,
including the common HAL modules.

2) wlan_remove.sh: Uninstalls the Wi-Fi specific modules only.

3) bt_remove.sh: Uninstalls the Bluetooth specific modules only.
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4) zigb_remove.sh: Uninstalls the Zigbee specific modules only.

4.8 Driver Information

4.8.1 Driver Statistics
Use the command below to view driver statistics:
# cat /proc/onebox-mobile/stats

This command prints statistics related to the total management packets,
total data packets with respect to a given access category sent to/from
the driver, buffer full status as well as semi buffer full status, FSM states
etc.

4.8.2 Disabling Driver Debug Prints

You may opt to disable the debug prints of the driver appearing on the
console using the command below. Ensure that the driver is installed
correctly before using this commad.

# echo 0x0 > /proc/onebox-mobile/debug_zone/
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5 Evaluation of Connect-io-n® /WiSeConnect®

5.1 Required Setup

The required setup is illustrated in figures in the sub-sections below for
evaluation in the following modes:

1) Wi-Fi Client in Personal Security Mode
2) Wi-Fi Client in Enterprise Security Mode
3) Wi-Fi Direct Mode

4) Wi-Fi Access Point Mode

NOTE: This section describes the evaluation process of the RS9113
modules in Connect-io-n®/WiSeConnect® modes for Wi-Fi using the
UART interface. Redpine Signals provides reference projects and APIs for
SPI, USB and USB-CDC for Wi-Fi only and also for Coexistence of Wi-Fi
with Bluetooth Classic, Bluetooth Low Energy and Zigbee. These are
provided as part of the release package along with information in Readme
files.

5.2 Getting Started

Please follow the steps below to get started with the evaluation process.
This process is explained for evaluation on a Windows PC.

1) Download and install a Serial Emulation program like Docklight,
Teraterm, etc. This document uses Docklight for explaining the
process. This software is relatively easy to use and allows the user to
monitor the serial port data while also enabling sending and receiving
data. However, since it does not support sending of files using Kermit,
it cannot be used to upgrade the firmware of the module. For
firmware upgradation, we suggest Teraterm. The process for firmware
upgradation is explained in Appendix C. Docklight can be downloaded
from http://www.docklight.de/download en.htm

2) Open Docklight and click OK when asked for Registration, to use it in
Evaluation mode.

3) In the dialog box that opens, select “Start with a blank project / blank
script” and click Continue.
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& Welcome to Docklight

Welcome to Docklight RS232 Terminal / R5232 Monitor, Choose from the
following options and start discovering some basic functions and features.

- 2 ~ Open a sample / demo project for sending test commands
B = to & standard analog modem

Open a sample / demo project and leain how to react to

g-.—pg " a specific data sequence received and send out new
data

& " Dpen an existing Docklight project [.ptp) file

1 & Start with a blank project / blank script

PP [ Do not show this dialog again in the future

http: /A docklight de

E-Mailto:  docklight@fuh-edv.de

Figure 4: Docklight Startup Dialog Box

4) Next, connect the EVB to the PC using the USB-to-microUSB cable.
Plug in the cable into the micro-USB port labeled "UART"” on the EVB.

5) Wait for the drivers to be installed the first time. Disconnect the EVB
and connect it again.

6) In Docklight, click on Tools -> Project Settings to open the dialog box
shown below.

Project Settings
| Flow Control | Communication Filter I

Communication Mode
1 2 Monitoring 1, 2

+ Send/Receive B-.—'_a " [recsive ==
only]

Send/Receive on Comm. Channel
COMS |

Choose a COM port from the list of available devices, or type a COM
port from COM1 to COM25E.

COM Port Settings

Baud Rate 115200 - Data Bits 8 -
Parity None - Stop Bits 1 -
Parity Error Char. |63 ('7) -

oK ‘ Cancel | Help ‘

Figure 5: Docklight Project Settings Dialog Box

7) Select the following options for the Serial port settings:

a. Select the COM port in the drop-down menu under
“Send/Receive on Comm. Channel”. In the above figure, it is
COMS.
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b. Select the Baud Rate as 115200.
c. Click OK.

8) Disconnect the EVB and follow the steps in the sub-sections below.
5.3 Wi-Fi Evaluation in UART Mode

The following sub-sections describe configuring and using the module in
in different security and operational modes of Wi-Fi.

5.3.1 Wi-Fi Client in Personal Security Mode

The figure below shows the setup required for this process.

UART
Interface
€ -- »
R59113 .
PC(P) WiSeConnect Access Point
Module (A) EB) )
Test AP
A
I
|
v
Laptop (C)

Figure 6: Setup for Wi-Fi Client in Personal Security Mode
In the setup shown in the figure, the RS9113 WiSeConnect/Connect-io-n
EVB is a Wi-Fi client. It connects to an Access Point configured in WPA2-
PSK security mode. The Access Point is configured with SSID as
“Test_AP” and IP address set as 192.168.50.1.The SSID and IP address
are for illustration only. The user is required to configure the AP based on
network domain in which wireless devices operate.

5.3.1.1 Wi-Fi Client Configuration
1) Open Docklight.

1) Connect the micro-USB cable between the USB port of the PC and the
micro-USB port of the EVB labeled "UART".

2) Hit “F5” key when in the Docklight window to start communicating
with EVB.

3) At powerup, the module tries to estimate the baud rate of the Host by
exchanging data with it. If no data is sent by the Host, the module
defaults to the 115200 bps baud rate in approximately 18 seconds.
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Please refer to the Software PRM document to understand the
Automatic Buad Rate Detection Process for faster bootup. At the end
of the timeout, you will see a message like, "WELCOME TO REDPINE
SIGNALS”, followed by multiple options. Please see the figure below.

Y

& Docklight V2.0 (Eval)
File Edit Run Tools Help Stop Communication (F6)

u - o @
L——= Commmunication port open ColorskFonts Mode COM8 115200, None, 8, 1
Send Sequences Communication

Send  Name Sequence ASCI | HEX | Decimal| Binary |
5 | i
1/16-2015 16:01:31.111 [RX] - <CR»<LF>»

Receive Sequences

Active Name Sequence Answer

WELCOME TO REDFINE SIGNALS<CR><LF>
BootLoader Version 1. 5<CR><LF>
<CR>»><LF>»

1 Load Image-I<CR><LF>

2 Upgrade Image-1 »<LF>

3 Load Image-II<CR:><LF>

4 UOpgrade Image-II<CR><LF>

5 Set Image-I as Default<CR:><LF>

6 Set Image-II as Default<CR><LF>

7 Enable GPIO Based Bypass Mode<C

8 Disable GPIO Based Bypass Mode<

A LOAD FIRMWARE (Image No 0-£)

B BURN FIRMWARE (Image No 0-£f)<CR
K CHECK CRC (Image No 0-f)<CR><LF>
D SWITCH DEFAULT IMAGE (Image No

LF>

0-f )<CR»><LF>

Figure 7: Module Startup Messages

4) Hit'1’ and press Enter. You will see a message that says, “Loading...”

followed by “Loading Done”.
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<& Docklight V2.0 (Eval) = =
File Edit Run Tools Help Stop Communication (F6)
(Rl - B 7 e
L——= Commmunication port open ColorskFonts Mode COM8 115200, None, 8, 1
Send Sequences Communication Keyboard Consale on - click ta tum off
Send  Name Sequence ASCI | HEX | Decimal| Binary |

I
1-16-2015 16:10:23 418 [RX] - <LF>
WELCOME TO REDPINE SIGNALS<CR> IF
BootLoader Version 1. 5<CR><LF>
(CR><LF>

Load Image-I<CR><LF>

Opgrade Image—l:i > ¢

Load Image-II¢
Upgladc— Imagc——l

) O U B GO P

Receive Sequences

Active Name Sequence Answer 8 Di=able fFFIf' Based b
A LOAD FIRMWARE ‘II\L-*EP— N’
B BURN FIRMWARE (Image No £
K CHECK CRC (Image No : 0-f)<CR> <LF>

D SWITCH DEFAULT IMAGE ( ImagE‘ Ho 0-f)<CR»<LF>

1-16-2015 16:10:24.103 [TX] - 1
171672015 16:10:24 .106 [RX] - 1<CR><LF>
Loading ><LF>

Loading Done<CR><LF>

Figure 8: Firmware Loading Messages

5) The following commands can now be issued to the module. Please
refer to the Software PRM document for detailed description of each
command and the expected responses. A command should not be
sent until the response for the previous command is received.

NOTE: Each AT command should have a suffix of Carriage Return <CR>
(Keyboard keys are Ctrl+Enter) and Line Feed <LF> (Keyboard keys are
Ctrl+Shift+Enter). This is enabled by default in Docklight.

a. at+rsi opermode=0,1,4,0

This command configures the module as Wi-Fi client. The module
responds with “"OK”

b. at+rsi band=0

This command configures the operating band of Wi-Fi client to
2.4GHz. The module responds with "OK”

c. at+rsi init

This command initializes the Wi-Fi module in the EVB. The module
responds with OK<MAC_Address>.

d. at+rsi fwversion?
This command displays current firmware version in use.
e. at+rsi scan=0

This command scans for available Access Points operating in the
2.4 GHz band. The module responds with information of the
Access Points scanned. The data received might have some
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unreadable characters because of ASCII conversion. You can use
the HEX tab of Docklight to see the bytes sent by the module.

f. at+rsi psk=1,12345678

This command configures the PSK of the Wi-Fi client with the key
entered by user. The User can enter any other key as PSK.

g. at+rsi join=Test AP,0,2,2

This command connects the Wi-Fi client to the Access Point with
SSID “Test_AP”. On successful association, the module responds
with OK.

h. at+rsi ipconf=0,192.168.50.10,255.255.255.0,192.168.50.1
at+rsi_ipconf=1,0,0,0

This command configures the IP address of the module. The IP
address configured in the above command is for illustration only.
The user has to configure the IP address as per the Access Point’s
settings using either Manual (first command above) or DHCP mode
(second command above).

For the Manual mode, ensure that the desired IP is in the same
subnet as the Access Point’s subnet. The module responds to this
command by sending the configured IP address to the Host. In the
terminal, this response might appear as unreadable characters
because of ASCII conversion. You can use the HEX tab of
Docklight to see the bytes sent by the module.

5.3.1.2 Test Procedure

The IP addresses configured in this process are meant for illustration
only. It is assumed that Wi-Fi client of the EVB is assigned an IP address
of 192.168.50.10 and Laptop C, connected to the Access Point is assigned
an IP address of 192.168.50.20.

The applications provided in the USB drive (as part of the release
package) send and receive TCP and UDP packets.

TCP and UDP applications are provided along with release package for
execution on the Laptop. These applications are located in the path
RS9113.NBZ.WC.GEN.OSI.x.x.x\utils\peer_applications\Windows where
RS9113.WSC.GENR.x.x.x is software package directory.

1) Open a TCP Server socket on the Wi-Fi Client (EVB) side using the
following AT command:

at+rsi 1ltcp=5001,1,0
2) The module’s response will look as follows:

OK<ip_ version><socket type><socket handle><Lport><module ip
addr>\r\n

The socket handle in the response above is used for subsequent
commands.

3) Open a TCP client socket on Laptop C by running the TCP.exe
application as follows in the Windows Command Prompt:
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TCP.exe ¢ 2001 192.168.50.10 5001

Ensure that you run the Windows Command Prompt program as an
Administrator and any firewalls which block creation of sockets are
disabled before running the application.

4) The above command opens a new window with the following options:

a. Send
b. Receive
c. Exit

5) Observe that the Docklight on the Wi-Fi Client side (EVB) prints the
following message, once the TCP connection is setup with Laptop C.

AT+RSI_LTCP_ CONNECT=<ip version><socket descriptor>,<dest p
ort no>,<dest ipaddr><mss><window size>

6) For testing the Receive mode of the Wi-Fi Client (EVB), follow the
steps below:

a. Type 1 in the TCP.exe window on Laptop C.

b. On being prompted to enter a data string to be transmitted,
type any string and hit Enter to transmit the typed data.

c. When the data is received on the Wi-Fi Client (EVB) side, you
will see a response (asynchronous) from the module as
follows:

AT+RSI_READ<ip version><socket handle><payload len><s
ource ip addr><source port><payload>

7) For testing the Transmit mode of the Wi-Fi Client (EVB), follow the
steps below:

a. Type 2 in the TCP.exe window on Laptop C.

b. On the Wi-Fi Client (EVB) side, send the command below to
transmit data to the Laptop C.

at+rsi snd=<socket handle>,<payload len>,<dest ipaddr
>,<dest port>,<payload >

c. The transmitted data is displayed on the TCP.exe window of
Laptop C.

8) The figure below is a snapshot of the TCP.exe application window.
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E:\visual studio 2010\Projects\TCP\Release) [CP.exe ¢ 2001 192.168.50.10 S001
Connected To The Server

Enter Option

1- Send, 2- Receive, 3- Exit

Entir The String To Be Transmitted:
es
Enter Option

%- Send, 2- Receive, 3- Exit
Naitins For Data To Be Sent From The Module

Server
Complete
Enter Option

1- Send, 2- Receive, 3- Exit

ata: abcdefghij

Figure 9: TCP Application Window

5.3.2 Wi-Fi Client in Enterprise Security Mode

The figure below shows the setup required for this process.

UART
Interface
Ethernet
\ *--- > Interface
RS9113- l
. Laptop/PC
pPC (p) | WiSeConnect Access Point (Sl; r?_,lr-[j{i;ﬂﬂg
Module (A) (B) Radius
“Test AP” Server
A
1
i
v
Laptop (C)

Figure 10: Setup for Wi-Fi Client in Enterprise Security Mode

In the setup shown in the above figure, the WiSeConnect® module on the
RS9113 EVB acts as Wi-Fi client. It connects to an Enterprise Security enabled
Access Point. The WiSeConnect® module supports four Enterprise Security
modes:

1) EAP-TLS
2) EAP-TTLS
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3)
4)

EAP-PEAP
EAP-FAST

5.3.2.1 Radius Server Configuration

Follow the steps below to setup a Radius Server on Laptop D as per the
setup shown in Figure 10. The process explained here is for a Windows
Laptop. A similar process may be followed for other OS.

1)

2)

3)

Download and install the FreeRADIUS server software from
http://www.freeradius.net/Downloads/FreeRADIUS.net-1.1.7-

r0.0.2.exe. The FreeRADIUS server software for other platforms is

available at http://freeradius.org/download.html .

Once installed, go to the C:\FreeRADIUS.net\etc\raddb folder and
make the following modifications.

Open the clients.conf file and add the following lines at the end of the
file.

client 192.168.50.1/24 {
secret = 12345678

shortname = private-network-1

}

The IP address in the above lines (192.168.50.1) is the IP address of
the Access Point in this example setup. The "12345678" input is the
key to be entered in the Access Point’s configuration to authenticate it
with the Radius Server.

4) Open the eap.conf file and make the following changes:

a. Change the input for the “default_eap_type” field under the
“eap” section to “tls”, as shown in the figure below.
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] eap.conf (C:\FreeRADIUS.net\etc\raddb) - GVIM  — =

File Edit Tools Syntax Buffers Window Help
auBéle | BBRRBIAESATAQ? A

Whatever you do, do NOT set 'Auth-Type := EAP'. The server
is smart enough to figure this out on its own. The most
common side effect of setting 'Auth-Type := EAP' is that the
users then cannot use ANY other authentication method.

$Id: eap.conf,u 1.4 2004/04/15 18:34:41 aland Exp $

* & & & & & wEd

eap {
Inuoke the default supported EAP type when
EAP-Identity response is received.

The incoming EAP messages DO NOT specify which EAP
type they will be using, so it MUST be set here.

H
#
H
#
#
#
# For now, only one default EAP type may be used at a time.
#
# If the EAP-Type attribute is set by another module,

# then that EAP type takes precedence over the

# default type configured here.

#

d

efault_eap_type = tls

# A list is maintained to correlate EAP-Response

H# packets with EAP-Request packets. After a

# configurable length of time, entries in the list
H expire, and are deleted.

#

1 change; before #1 1 seconds ago 1.1 Top

Figure 11: Default EAP Type

b. Change the inputs for “private_key_file”, “certificate_file” and

“CA_file” fields under the “tIs” section to
“${certsdir}/wifiuser.pem”, as show in the figure below.
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% eap.conf + (C:\FreeRADIUS.net\etc\raddb) - GVIM - B

File Edit Tools Syntax Buffers Window Help
ARBE| 9 | BRREB|ISZSA TS ? 2

.. /seripts/certs.sh

The documents on http://uwu. freeradius.org/doc
are old, but may be helpful.

See also:

http://www.dslreports. com/forum/remark, 9286052 " mode=flat

Ll

1s
private_key_password = demo
private_key_file = E{certsdir)/uifiuser.pem

If Private key & Certificate are located in
the same file, then private_key_file &
certificate_file must contain the same file
name .

certificate_file = ${certsdir}/wifiuser.pem

*+ R

# Trusted Reoot CA list
CA_file = ${certsdir}/wifiuser.pen

dh_file = $(certsdir)/dh
random_file = $(certsdir}/random

#
# This can neuver exceed the size of a RADIUS v
/A\$(certsdir\)\/wifiusery . pem ~@F 124, 23-44 4y%

Figure 12: TLS Section -1

c. Uncomment the “fragment_size” and “include_length” lines
under the “tls” section, as shown in the figure below.

% eap.conf + (C:\FreeRADIUS.net\etc\raddb) - GVIM - B

File Edit Tools Syntax Buffers Window Help

AB&| 9 @ BRRasIATHE9 7R

This can never exceed the size of a RADIUS ~
packet (4096 bytes), and is preferably half

that, to accomodate other attributes in

RADIVUS packet. On most APs the MAX packet

length is configured between 1500 - 1600

In these cases, fragment size should be

1024 or less.

*

B -

ragment_size = 1024

include_length is a flag which is
by default set to yes If set to
yes, Total Length of the message is
included in EVERY packet we send.
If set to no, Total Length of the
message is included OMLY in the
First packet of a fragment series.

L

include_length = yes
Check the Certificate Revocation List

1) Copy CA certificates and CRLs to same directory.
2) Execute 'c_rehash <CA certs&CRLs Directory>"
‘c_rehash’ is OpenSSL's command.
3) Add 'CA_path=<CA certs&CRLs directory>’
te radiusd.conf's tls section.
4) uncomment the line below. v
139,2-16 S5%

E R
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d. Change the input for the “default_eap_type” field under the “ttls”
section to "mschapv2”, as shown in the figure below.

%

eap.conf + (C:\FreeRADIUS.net\etc\raddb) - GVIM - 0

File Edit Tools Syntax Buffers Window Help

S IFEIE]

BRRRSISA TaQ? R

/mschapu2

ol R

and configured, in order to use the TLS tunnel ~
inside of the EAP packet. VYou will still need to

configure the TLS module, euven if you do not want

to deploy EAP-TLS in your network. Users will not

be able to request EAP-TLS, as it requires them to

have a client certificate. EAP-TTLS does not

require a client certificate.

tls {

The tunneled EAP session needs a default
EAP type which is separate from the one for
the nen-tunneled EAP module. Inside of the
TTLS tunnel, we recommend using EAP-MDS.
If the request does not contain an EAP
conversation, then this configuration entry
is ignhored.

efault_eap_type = mschapu2

O 33 3 H NN

The tunneled authentication request does
not usually contain useful attributes
like 'Calling-Station-Id', etc. These
attributes are outside of the tunnel

and normally unavailable to the tunneled
authentication request.

By setting this configuration entry to

‘yes', any attribute which NOT in the

tunneled authentication reguest, but v
203,23-44 T4%

E R

Figure 14: TTLS Section

5) Open the users.conf file and add the lines shown in the figure below
starting with “user1”. This adds a user with username “userl1” and

password “test123".
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# users.conf + (C:\FreeRADIUS.net\etc\raddb) - GVIM

File Edit Tools Syntax Buffers Window Help
aZDa| e e| B BRRSESA THEa 2?2

_ oEN

# Framed-Compression = Uan-Jacobsen-TCP-IP

#

# This is an entry for a user with a space in their name.
# Note the double quotes surrounding the name.

#

#"John Doe™ Auth-Type := Local, User-Password == "hello”

# Reply-Message = "Hello, %u"

“user1” Cleartext-Password := "test123”
Reply-Message = "Hello, %(User-Hame}"
#

# Dial user back and telnet to the default host for that port

#

#Deg Auth-Type := Local, User-Password == "ge55Sged”
# Service-Type = Callback-Login-User,
Login-IP-Host = 0.0.0.0,

Callback-Number = “9,5551212",

Login-Service = Telnet,

Login-TCP-Port = Telnet

E- o

#

# Another complete entry. After the user “dialbk” has logged in, the

# connection will be broken and the user will be dialed back after which v

Figure 15: User Addition

6) Copy the wifiuser.pem file from

116,38-45 50%

RS9113.NBZ.WC.GEN.OSI.x.x.x\utils\Radius_Server\raddb\certs

folder to

C:\FreeRADIUS.net\etc\raddb\certs\FreeRADIUS.net\DemoCerts

folder.

7) Ensure that the FreeRADIUS server is not running. Open the Windows
Command Prompt with Administrator privileges and navigate to the

C:\FreeRADIUS.net folder.

8) Run the “start_radiusd_debug.bat” batch file. You will see a series of
prints on the screen. Monitor the prints to ensure that all changes are
done correctly. The Radius server has started successfully if you see a
print at the end which says, “"Ready to process requests.”

5.3.2.2 Access Point Configuration

Follow the steps below to configure the Access Point in the setup shown
in Figure 10 to work with the Radius server started on Laptop D.

1) Connect the Access Point to Laptop D over Ethernet and open the
Access Point pages in a browser by typing the IP address of the

Access Point.

2) Navigate to the Wireless Security section and enable the "“WPA/WPA2
- Enterprise” option, as shown in the figure below. The page below is

for a TP-Link Access Point.
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TL-WR740N

€ 192168501

TP-LINK

Status
Quick Setup
ass
Network
Wireless
Settings
Security
E MAC Filtering
- Wireless Advanced
- Wireless Statistics
DHCP
Forwarding
Security
Parental Control
Access Control
Advanced Routing
Bandwidth Control
1P & MAC Binding
Dynamic DNS

System Tools

F=TEx)

AlulB ¥ R =E

150M Wireless Lite N Router
Model No. TL-WRT740N / TL-WR740ND

Wireless Security

© Disable Security

Version:
Encryption:

Password:

Group Key Update Period:

®

WPA/WPA2 - Enterprise
Version:
Encryption:
Radius Server IP:
Radius Port:
Radius Password:

Group Key Update Period:

o WEP
Type:
WEP Key Format:
Key Selected
KeyT: @

Key 2

Key 3

Keyd:

Automatic(Recommended) ~

Automatic(Recommended) +

(You can enter ASCII characters between 8 and 63 or Hexadecimal characters between 8 and 64.)

0 Seconds (Keep it defaultif you are not sure, minimum is 30, 0 means na update)
Automatic -

Automatic -

192168.50.100

1812 (165535, 0 stands for default port 1812)

12345678

0 (in second, minimum is 30, 0 means no update)

OpenSystem
Hexadecimal  ~

WEP Key (Password) Key Type
Disabled ~
Disabled ~
Disabled +

Disabled ~

<[

1@ Mtlooks like you haven't started Firefox in a

while. Do you want ta clean it up for a fresh, ike-new experience? And by the way, welcome back!

Wireless Security Help
You can select one of the following security aptions:

® Disable Security - The wireless security function can be enabled or
disabled. If disabled, the wireless stations will be able to connect the
Device without encryption. It is recommended strongly that you choose one
of following options to enable security.
® VWPAWPA2 - Personal - Select WPA based on pre-shared passphrase.
PAIWVPAZ - Enterprise - Select WPA based on Radius Server
® WEP - Select 802.11 WEP security

Each security option has its own setiings as described fallows,
WPAWPA2 - Personal
Version - You can select ane of following versions,

* Automatic - Select WPA-Personal or WPA2-Personal automatically based

on the wireless statio's capabilty and request

® WPA-Personal - Pre-shared key of WPA

® WPA2-Personal - Pre-shared key of WPA2.
Encryption - You can select sither Automatic, or TKIP of AES.
Password - You can enter ASCIl or Hexadecimal characters. For Hexadecimal, the
length should be between & and 64 characters; for ASCIL, the length should be
between 8 and 63 characters,

Group Key Update Period - Specify the group key update interval in secands. The
value can be sither 0 or at least 30. Enter 0o disable the update

WPAPAZ - Enterprise

Version - You can select ane of following versions,
® Automatic - Select WPA or WPA2 automatically based on the wireless
station’s capability and request
® VUPA - Wi-Fi Protected Access
® WPA2 - WPA version 2.
Encryption - You can select either Automatic, or TKIP o AES.
Radius Server IP - Enter the IP address of the Radius Server
Radius Port - Enter the port that radius service used.
Radius Password - Enter the password for the Radius Server

Group Key Update Period - Speciy the group key update interval in seconds. The
value can be either 0 or atleast 30. Enter 0 1o disable the update.

WEP

Type - You can select ane of following types,

Reset Firefox.. | x

Figure 16: Wireless Security Configuration of Access Point

3) Enter the IP address of the Radius Server in the field labeled, “"Radius
Server IP”. In the above figure, it is 192.168.50.100.

4) Enter the Radius Password as “12345678". This is the same as that
entered in the clients.conf file of the Radius Server.

5.3.2.3 Wi-Fi Client Configuration
1) Open Docklight.

2) Connect the micro-USB cable between the USB port of the PC and the
micro-USB port of the EVB labeled "UART".

3)

with EVB over the serial COM port.

4)

Hit “F5"” key when in the Docklight window to start communicating

At powerup, the module tries to estimate the baud rate of the Host by

exchanging data with it. If no data is sent by the Host, the module
defaults to the 115200 bps baud rate in approximately 18 seconds.
Please refer to the Software PRM document to understand the
Automatic Buad Rate Detection Process for faster bootup. At the end
of the timeout, you will see a message like, “"WELCOME TO REDPINE
SIGNALS”, followed by multiple options. Please see the figure below.
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& Docklight V2.0 (Eval) - ol El
File Edit Run Tools Help Stop Communication (F6)

wHE| | LR BB G m

L——= Commmunication port open ColorskFonts Mode COM8 115200, None, 8, 1
Send Sequences Communication
Send  Name Sequence ASCI | HEX | Decimal| Binary |

1-16-2015 16:01:31.111 [RX] — <CR><LF>
WELCOME TO REDPINE SIGNALS<CR><LF>
BootLoader Version 1.5<C
<CR><LF>

1 Load Image-I<CR><
2 Upgrade Image-I1¢
3 Load Image-II<C
4 UOpgrade Image-I1
5
6
7

Set Image-I as Default
Set Imag:— II as Default< >

> Enable GPIO Based Bypass Ml:nd.e- IF. <LF>
Active | Name Sequence Answer 8 Disable GPIO Based Bypass Mode<CR><LF>
A LOAD FIRMWARE (Image No 0—f )<
} BURN FIRMWARE (Image No 0—£)«(
{ CHECK CRC {Image No : 0-f)<CR><LF:>
D SWITCH DEFAULT IMAGE (Image No 0-f)<CR»<LF>

Receive Sequences

Figure 17: Module Startup Messages

5) Hit'1’" and present Enter. You will see a message that says,
“Loading...” followed by “Loading Done”

& Docklight V2.0 (Eval) - ol El
File Edit Run Tools Help Stop Communication (F6)

wHE s P HR B

L——= Commmunication port open ColorskFonts Mode COM8 115200, None, 8, 1
Send Sequences Communication Keyboard Consale on - click ta tum off
Send  Name Sequence ASCI | HEX | Decimal| Binary |

5 | i
1-16-2015 16:10:23 418 [RX] — <CR»><LF>
WELCOME TO REDFINE SIGNALS<CR><LF>
BootLoader Version 1.5<C
<CR><LF>

1 Load Image-I<CR><
2 Upgrade Image-I1¢

3 Load Image-II<C

4 UOpgrade Image-II<C
5

6

7

Set Image-1I as I\E-fau.lt
Set Imag:— II as Default< >

> Enable GPIO Based Bypass Ml:nd.e- IF. 'IF>
Active . Name Sequence Answer g Disable GPIO Based EBypass Mode<C ;
A LOAD FIRMWARE (Image No 0—£ )«
} BURN FIRMWARE (Image No D-fh:l <
K CHECK CRC (Image No : 0-f)<CR><LF>
D SWITCH DEFAULT IMAGE (Image No 0-f)<CR»<LF>

Receive Sequences

672015 16:10:24 103 [TX] - 1
#16-2015 lr: 10:24 106 [RX] - 1<CR><LF>
Loading CR><LF>

Loading Dr:wnEu CR><LF>

Figure 18: Firmware Loading Messages

6) The following commands can now be issued to the module. Please
refer to the Software PRM document for detailed description of each
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command and the expected responses. A command should not be
sent until the response for the previous command is received.

NOTE: Each AT command should have a suffix of Carriage Return <CR>
and Line Feed <LF>. This is enabled by default in Docklight.

i. at+rsi opermode=2,0,4,0

This command configures the module as Wi-Fi client. The module
responds with “"OK”

J. at+rsi band=0

This command configures the operating band of Wi-Fi client to
2.4GHz. The module responds with "OK”

k. at+rsi init

This command initializes the Wi-Fi module in the EVB. The module
responds with OK<MAC_Address>.

1. at+rsi eap=TLS,MSCHAPVZ,userl, testl23,0
at+rsi eap=TTLS,MSCHAPV2,userl, testl23,0
at+rsi eap=PEAP,MSCHAPV2,userl, testl23,0
at+rsi eap=FAST,MSCHAPVZ,userl, testl23,0

These commands set the EAP mode for the module and set the
authentication credentials (username and password). Issue one of
them based on which mode needs to be evaluated.

m. To verify the EAP-TLS mode, a security certificate file should be
loaded into the module. A Python based script is provided to do the
same since loading of certificate files cannot be done through
Docklight. Please download and install Python for Windows from
https://www.python.org/downloads/release/python-279/. In
addition, please download and install the Pyserial program for
accessing the Serial COM port from Python. This is available at
https://pypi.python.org/pypi/pyserial.

NOTE: Please download the 32-bit version of Python for Windows from
the above link even if your PC is 64-bit since the 64-bit version does not
update the registry correctly, which causes a problem during the
installation of the Pyserial application.

n. Open load_certificate.py file and change the serial port name
to "COMS8" as shown in the line below. This is the Serial COM
port that was detected in Docklight earlier.

sp=serial.Serial (port="COM8",baudrate=115200, timeout=
0.01)

o. Disable Docklight’s serial port connection to the EVB by hitting
‘F6’ when the Docklight window is open.

p. Open the Windows Command Prompt and navigate to the
RS9113.NBZ.WC.GEN.OSI.x.x.x\utils\Python folder and give
the following command:
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C:\Python27\python.exe load certificate.py 1
..\Radius_Server\raddb\certs\wifiuser.pem

This command loads the TLS Certificate into the module.

g. Go back to the Docklight window and hit “F5” to enable the
serial port connection between Docklight and the EVB and
continue giving the commands below.

r. For non-TLS modes, issue the command below to clear any
certificates that might have been loaded previously.

at+rsi cert=1,0,0,0

This command should NOT be given for TLS mode after the
at+rsi_eap command.

s. at+rsi scan=0

This command scans for available Access Points operating in the
2.4 GHz band. The module responds with information of the
Access Points scanned. The data received might have some
unreadable characters because of ASCII conversion. You can use
the HEX tab of Docklight to see the bytes sent by the module.

t. at+rsi join=Test AP,0,2,2

This command connects the Wi-Fi client to the Access Point with
SSID “Test_AP”. On successful association, the module responds
with OK.

u. at+rsi ipconf=0,192.168.50.10,255.255.255.0,192.168.50.1
at+rsi ipconf=1,0,0,0

This command configures the IP address of the module. The IP
address configured in the above command is for illustration only.
The user has to configure the IP address as per the Access Point’s
settings using either Manual (first command above) or DHCP mode
(second command above).

For the Manual mode, ensure that the desired IP is in the same
subnet as the Access Point’s subnet. The module responds to this
command by sending the configured IP address to the Host. In the
terminal, this response might appear as unreadable characters
because of ASCII conversion. You can use the HEX tab of
Docklight to see the bytes sent by the module.

v. at+rsi 1ltcp=5001,1,0
This command opens a Listen TCP socket with port number 5001.
5.3.2.4 Test Procedure

1) Connect Laptop C to the Access Point. It should have proper security
credentials to connect to the AP.
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2) A “ping!” can be issued from Laptop C to the Wi-Fi module to verify
connectivity through the AP.

3) TCP and UDP applications are provided along with release package for
execution on the Laptop C. These applications are located in the path
RS9113.NBZ.WC.GEN.OSI.x.x.x\utils\peer_applications\Windows
where RS9113.WSC.GENR.x.x.x is software package directory. Open a
client TCP socket on the Laptop C using the following command in a
Windows Command Prompt.

TCP.exe ¢ 2001 <EVB IP address> 5001

4) The above command opens a new window with the following options:

a. Send
b. Receive
c. Exit

5) Observe that the terminal on the Wi-Fi Client side (EVB) prints the
following message, once the TCP connection is setup with Laptop C.

AT+RSI_LTCP CONNECT=<ip version><socket descriptor>,<dest p
ort no>,<dest ipaddr><mss><window_ size>

6) For testing the Receive mode of the Wi-Fi Client (EVB), follow the
steps below:

a. Type 1 in the TCP.exe window on Laptop C.

b. On being prompted to enter a data string to be transmitted,
type any string and hit Enter to transmit the typed data.

c. When the data is received on the Wi-Fi Client (EVB) side, you
will see a response (asynchronous) from the module as
follows:

AT+RSI_READ<ip version><socket handle><payload len><s
ource ip addr><source port><payload>

7) For testing the Transmit mode of the Wi-Fi Client (EVB), follow the
steps below:

a. Type 2 in the TCP.exe window on Laptop C.

b. On the Wi-Fi Client (EVB) side, send the command below to
transmit data to the Laptop C.

at+rsi snd=<socket handle>,<payload len>,<dest ipaddr
>,<dest port>,<payload >

c. The transmitted data is displayed on the TCP.exe window of
Laptop C.

NOTE: To switch between Enterprise Security and any other security
modes (WPA2-PSK, WPA, WEP) Operation mode has to be changed.

1 The module responds to a ping request sent from a remote terminal. There is no
command to send a ping request from the module. This is true in all the modes-
Client, AP and Wi-Fi Direct.
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Enterprise security works in Operation mode 2 and for other security
modes the Operation mode is 0. The Change in the Operation mode
command can happen just after the Reset (soft reset or hard reset) so
Reset is required to toggle between Enterprise Security and other security
modes.

5.3.3 Wi-Fi Direct Mode
The figure below shows the setup required for this process.

UART
Interface
R59113 Wi-Fi Direct Mobile
PC WiSeConned Phone or other Wi-
Module (A) Fi Direct device (B)

5.3.3.1 Wi-Fi Configuration

1) Enable Wi-Fi Direct Mode in the phone. A screenshot of an Android
phone’s Wi-Fi Direct Settings is shown in the figure below. This is
usually available in the Wi-Fi Settings of the phone.

Wi-Fi Direct settings

Wi-Fi Direct

Configure Wi-Fi Direct

Status

Disconnected

Wi-Fi Direct devices Scanning O

Figure 19: Android Phone’s Wi-Fi Direct Settings

The “Configure Wi-Fi Direct” button can be clicked to set the device
name accordingly (Android_phone in this case).
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2) Follow steps 1 to 3 in Section 5.2.1.1 to power up the EVB and load
the firmware.

3) Enter the following commands. A command should be entered only
after getting the response of the previous command

a. at+rsi opermode=1,0,20,0

This configures the EVB to function in Wi-Fi Direct mode. The
module responds with “"OK".

b. at+rsi band=0

This configures the operating band of the EVB. The module
responds with “"OK".

c. at+rsi init

This initializes the Wi-Fi module in the EVB. The module responds
with OK<MAC_Address>.

d. at+rsi fwversion?

This is an optional command to report the firmware version in use.
e. at+rsi wfd=0,RED,1,wiseconnect, 12345678

This starts the Wi-Fi Direct functionality in the module.

The first parameter in this command is called the
Group_Owner_Intent. 1t gives the willingness of the module to
become a Group Owner. It has been set to the lowest value of 0 in
this case. Refer to the Programming Reference Manual for more
details. The module responds with “OK".

4) After issuing the last command, the module starts scanning for Wi-Fi
Direct devices, and reports any that are found through the
asynchronous message AT+RSI WFDDEV

5) After the module reports Wi-Fi Direct devices, issue the Join command
to connect.

at+rsi join=Android phone, 0,2

In this example, it is assumed that the device name of the phone is
configured as “Android_phone”. The phone should also display the
device name of the module (RED in this example). Within about 10
secs of issuing the Join command in the module, click *Connect” on
the phone as well to connect to the module. On successful
connection, the module responds with OK and the Phone displays
“Connected”

6) If the module has NOT become a GO (Group Owner), issue the below
command to get an IP address from the phone over DHCP. If the
module has become a GO, this command need not be issued.

at+rsi_ ipconf=1,0,0,0

The acquired IP address is returned to the Host but might not be
readable on the Docklight because of ASCII conversion. You can use
the HEX tab of Docklight to see the bytes sent by the module.
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Please refer to the description for the Join command in the
Programming Reference Manual. The parameter GO_Status returned
with the OK response of the Join command is used to determine
whether the module became a GO or not. If the module becomes the
GO, it will internally assign itself the IP 192.168.100.76 and will act as
a DHCP server. The Wi-Fi Direct phone will acquire an IP address from
the module automatically (assuming DHCP client is enabled in the
phone). Since the Group_Owner_Intent has been set to the lowest
value, module will become a Wi-Fi Direct client.
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5.3.3.2 Test Procedure

In the following descriptions it is assumed for illustrative purposes that
the module’s IP address is 192.168.100.76 and the remote peer
(phone) IP address is 192.168.100.77.

Running Ping Application

A ping application can be run from the Wi-Fi Direct Phone, with the
destination address as 192.168.100.76. The module will send the ping
response. Ping based applications are freely available for Android phones.

Exchanging data through sockets

For exchanging data between the module and the Wi-Fi Direct Phone, an
application may be written by the user at the mobile phone to open
sockets and transmit or receive data. At the module side, sockets can be
opened by using the below commands:

1) To open a server TCP socket in the module, issue the below
command.

at+rsi 1ltcp=5001,1,0

5001 is the example port number of the socket opened. Once the
socket is opened, a client socket should be opened at the remote peer
(phone) to connect to this socket and establish a TCP connection. The
module responds with

OK<ip version ><socket type> <socket handle><Lport>
<module ipv4addr>\r\n

The socket handle parameter will be used in the subsequent
sections to send data.

2) After the TCP connection is established, data can be exchanged
between the two nodes. To send data from the module, issue the
following command in Docklight:

at+rsi snd=<socket handle>, 8,0,0,abcdefgh
where abcdefgh is the data stream to be transmitted to the remote
Peer and socket handle is the parameter returned when the TCP

socket is opened in the module. Refer to the programming reference
manual for more details.

If the remote peer sends data to the module, the module receives it
and shows the data in the terminal with the message

AT+RSI_READ<ip version><socket handle><payload len><source_
ip_addr><source port><payload>

5.3.4 Wi-Fi Access Point Mode

The figure below shows the setup required for this process.
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5.3.4.1 Access Point Configuration Through AT Commands

1) Follow steps 1 to 3 in Section 5.2.1.1 to power up the EVB and load
the firmware.

2) Enter the following commands. A command should be entered only

after

a.

getting the response of the previous command
at+rsi opermode=6,1,48,0

This configures the EVB to function in AP mode. The module
responds with “"OK".

. at+rsi band=0

This configures the operating band of the EVB. The module
responds with “"OK".

. at+rsi init
This initializes the WiFi module in the EVB. The module
responds with OK<mac_address>

. at+rsi fwversion?

This is an optional command to report the firmware version in
use.

. at+rsi ipconf=0,192.168.0.30,255.255.255.0,192.168.0.
30

This command configures the IP (192.168.0.30 in this
example) of the AP. If this command is not issued, a default IP
of 192.168.100.76 will be used.

. at+rsi apconf=6,redpine,0,0,0,200,3,3
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The SSID is configured as “redpine”, to operate in channel 6.
Please refer to the Software PRM for more details on the other
parameters of this command.

g. at+rsi join=redpine,0,2,0
This starts the Access Point functionality in the module.

The module is now configured as an Access Point. Its IP address is
192.168.0.30. A Laptop can now scan for networks and the SSID of
the module, “redpine” will be displayed in the Laptop’s list of Scanned
APs. After the client Laptop (B) connects to the AP, it acquires an IP
address over DHCP. The IP address assighed to the laptop can be
known by opening the Windows Command Prompt and issuing the
command “ipconfig”. It is assumed for illustrative purposes that the IP
of the Laptop is 192.168.0.32.

5.3.4.2 Test Procedure

The applications provided in the USB drive (as part of the release
package) send and receive TCP and UDP packets.

TCP and UDP applications are provided along with release package for
execution on the Laptop. These applications are located in the path
RS9113.NBZ.WC.GEN.OSI.x.x.x\utils\peer_applications\Windows where
RS9113.WSC.GENR.x.x.x is software package directory.

1) Open a TCP Server socket on the Wi-Fi Client (EVB) side using the
following AT command:

at+rsi 1ltcp=5001,1,0
2) The module’s response will look as follows:

OK<ip version><socket type><socket handle><Lport><module ip
addr>\r\n

The socket handle in the response above is used for subsequent
commands.

3) Open a TCP client socket on Laptop C by running the TCP.exe
application as follows in the Windows Command Prompt:

TCP.exe ¢ 2001 192.168.0.30 5001

Ensure that you run the Windows Command Prompt program as an
Administrator and any firewalls which block creation of sockets are
disabled before running the application.

4) The above command opens a new window with the following options:

a. Send
b. Receive
c. Exit

5) Observe that the Docklight on the Wi-Fi AP side (EVB) prints the
following message, once the TCP connection is setup with Laptop C.

AT+RSI LTCP CONNECT=<ip version><socket descriptor>,<dest p
ort no>,<dest ipaddr><mss><window_ size>
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6) For testing the Receive mode of the Wi-Fi AP (EVB), follow the steps
below:

a. Type 1 in the TCP.exe window on Laptop C.

b. On being prompted to enter a data string to be transmitted,
type any string and hit Enter to transmit the typed data.

c. When the data is received on the Wi-Fi AP (EVB) side, you will
see a response (asynchronous) from the module as follows:

AT+RSI READ<ip version><socket handle><payload len><s
ource ip addr><source port><payload>

7) For testing the Transmit mode of the Wi-Fi AP (EVB), follow the steps
below:

d. Type 2 in the TCP.exe window on Laptop C.

e. On the Wi-Fi AP (EVB) side, send the command below to
transmit data to the Laptop C.

at+rsi snd=<socket handle>,<payload len>,<dest ipaddr
>,<dest port>,<payload >

f. The transmitted data is displayed on the TCP.exe window of
Laptop C.

5.4 Configuration Over Wi-Fi

The module can be configured wirelessly to join a specific AP (referred to as
“auto-connect”) or create an Access Point (referred to as “auto-create”).

5.4.1 Configuration to Connect to an Access Point

Flow 1: In this flow, an AP is first created in the module, to which a remote
device connects and configures the module.

UART
Interface

\ RS9113 *+— - »
WiseConnect

Module as AP Laptop (B)

PC (P)

Figure 21: Module Configured as Access Point

1. Connect a PC or Host to the module through the USB and power up
the module.
1) Configure the module to become an AP by issuing commands from PC

(P) as in section Evaluation of Access Point Mode. The sequence of
commands is given below.
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a. at+rsi_opermode=6,1,18,0
b. at+rsi_band=0

. at+rsi_init

. at+rsi_fwversion?

. at+rsi_ipconf=0,192.168.0.30,255.255.255.0,192.168.0.30
at+rsi_apconf=6,redpine,0,0,0,100,3,4

b I B = e |

g. at+rsi_join=redpine,0,2,0

The module is now configured as an Access Point. Its IP address is
192.168.0.30.
2) Connect a Laptop (B) to the created AP. Open the URL

http://<Module’s IP address>/Index.htm in the Laptop. In this
case, the URL is http://192.168.0.30/Index.htm Make sure the
browser in the laptop does not have any proxies enabled.

3) In the web page that opens, displaying the "“Welcome to Redpine
Signals” and click on the "GO TO CONFIGURATION PAGE” as shown in
below.

‘ Welcome to Redpine Signals

WiSeConnect

‘ ‘GO TO CONFIGURATION PAGE |

Figure 22: Module web page
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4) After that appears the “"WiSeConnect Wireless Configuration” page, in
the page select

OPERATING MODE: Client

BAND (GHZ): 2.4

SSID: This is the SSID of the AP to which the module should connect
after configuration is over.

TX POWER: RF power for Tx. Set to ‘2.

CHANNEL: Channel number at which the target AP is present. Set to “"11”
in this example.

SECURITY ENABLE and PSK: This should match the security mode of the
AP to which the module should connect (in this example AP is open
mode, so no need to enter the PSK value).

IP VERSION: set IPv42

DHCP: If DHCP is selected, the module will work as a DHCP client,
otherwise, an IP should be hard coded in the web page.

For more details, refer to the section on wireless configuration in the
PRM.

2 The module supports iPv6 also. Please refer to the PRM for IPv6 related details.

Redpine Signals, Inc. Proprietary and Confidential Page 54



User Guide

RS9113 Module Evaluation Kit . REDPlnE®
:)‘ SIGNALS

Version 2.0 DRIVING WIRELESS CONVERGENCE
WiSeConnect Wireless Configuration
OPERATING MODE @ Client © Enterprise Client & Access Point
BAMND (GHZ) @ 24 @ 50

SSID belkin@123
TX POWER 2

CHANNEL 11 0-11
SECURITY ENABLE =1
PSK

SECURITY TYPE @ wPA  © WPA2
ENCRYPTION TYPE @ TKIP  © AES
IP VERSION 1Py E|
DHCP

IP ADDRESS
SUBNET MASK

GATEWAY
IPV6 DHCP [

IPVE ADDRES S : : : : : : : i
ROUTER ADDRESS
BEACOMN INTERVAL 20-1000
DTIM COUNT 1-255
EAP TLE [=]

INNER METHOD
USER IDENTITY

PASSWORD

FIRMWARE UPGRADE

Figure 23: Wireless Configuration page

Click on "SUBMIT"” button. The information is sent to the module and stored in
its internal flash.

5) The module should now be power cycled or hard reset. It boots up
and then automatically scans channels for the target AP and connects
to it and gets an IP address. The module will send out two responses
to the Host, the first corresponds to the internally given “Join”
command and the second to the “Set IP Parameters” command. Note
that once the module is restarted, no commands need to be given.
The module automatically scans and joins the target AP, after which
the stored configuration parameters can be retrieved using the
command “at+rsi_cfgget”. If the auto-connect feature needs to be
disabled, issue the command “at+rsi_cfgenable=0". Refer to the PRM
for more details on these commands.

Flow 2: In this flow, the module is connected to an AP. A remote device
connects to the same AP and configures the module.

Redpine Signals, Inc. Proprietary and Confidential Page 55



RS9113 Module Evaluation Kit . REDPlnE®
E)l SIGNALS

User Guide

Version 2.0 DRIVING WIRELESS COMVERGENCE
UART
Interface
l RS9112 +— - —- >
Ni t i
PC (P) WiSeConnect Access Point (B)
Module B
4
/
/
/
Laptop(C)

1) Connect a PC or Host to the module through the USB and power up
the module.

2) Configure the module to become a client and connect to an AP as
described in section Evaluation of Client Mode with Personal Security.

3) Connect a Laptop (C) to the same AP. Open the URL
http://<Module’s IP address>/Index.htm in the Laptop. For
example, if the module was configured to have an IP of
192.168.100.20, then the URL is http://192.168.100.20/Index.htm.
Make sure the browser in the laptop does not have any proxies
enabled.

4) In the web page that opens, displaying the "Welcome to Redpine
Signals” and click on the "GO TO CONFIGURATION PAGE" (displaying
the web page in figure 23).

5) After that displaying the "WiSeConnect Wireless Configuration” page,
in the page select

OPERATING MODE: Client
BAND (GHZ): 2.4

SSID: This is the SSID of the AP to which the module should connect
after configuration is over.

TX POWER: RF power for Tx. Set to ‘2.

CHANNEL: Channel number at which the target AP is present. Set to "11”
in this example.
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SECURITY ENABLE and PSK: This should match the security mode of the
AP to which the module should connect (in this example AP is open
mode, so no need to enter the SECURITY ENABLE and PSK value).

IP VERSION: set IPv4

DHCP: If DHCP is selected, the module will work as a DHCP client,
otherwise, an IP should be hard coded in the web page.

For more details, refer to the section on wireless configuration in the

PRM.
WiSeConnect Wireless Configuration
OPERATING MODE @ Client ~ Enterprise Client ~ Access Point
BAND (GHZ) @ 24 2 50
SSID belkin@123
TX POWER 2
CHANNEL 11 o-11

SECURITY ENABLE =
PSK

SECURITY TYPE @ WPA D WPA2
ENCRYPTION TYPE @ TKIP ) AES
IP VERSION 1Py [=]

DHCP
IP ADDRESS
SUBNET MASK
GATEWAY
IPV6 DHCP [

IPV6 ADDRESS E E E E B E E I
ROUTER ADDRESS
BEACON INTERVAL 20-1000
DTIM COUNT 1-255
EAP LS [~

INNER METHOD
USER IDENTITY

PASSWORD

FIRMWARE UPGRADE

Figure 25: Wireless Configuration Page

Click on “SUBMIT” button. The information is sent to the module and stored in
its internal flash.

6) The module should now be power cycled or hard reset. It boots up
and then automatically scans channels for the target AP and connects
to it and gets an IP address. The module will send out two responses
to the Host, the first corresponds to the internally given “Join”
command and the second to the “"Set IP Parameters” command. Note
that once the module is restarted, no commands need to be given.
The module automatically scans and joins the target AP, after which
the stored configuration parameters can be retrieved using the
command “at+rsi_cfgget”. If the auto-connect feature needs to be
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disabled, issue the command “at+rsi_cfgenable=0". Refer to the PRM
for more details on these commands.

5.4.2 Configuration to Create an Access Point

Flow 1: In this flow, an AP is first created in the module, to which a remote
device connects and configures the module.

UART
Interface
RS9113 -~ == >
WiSeConnect
PC (P) | Laptop (B)
Module

Figure 26: Module Configured as Access Point

1) Connect a PC or Host to the module through the USB and power up
the module.

2) Configure the module to become an AP by issuing commands
through PC (P).

3) Connect a Laptop (B) to the created AP. Open the URL
http://<Module’s IP address>/Index.htm in the Laptop. For
example, if the module was configured to have an IP of
192.168.100.1, then the URL is http://192.168.100.1/Index.htm.
Make sure the browser in the laptop does not have any proxies
enabled.

4) In the web page that opens, displaying the "*Welcome to Redpine
Signals” and click on the "GO TO CONFIGURATION PAGE” as shown in
below
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‘ Welcome to Redpine Signals

WiSeConnect

‘ ‘GO TO CONFIGURATION PAGE ‘

Figure 27: Module web page

5) After that displaying the "WiSeConnect Wireless Configuration” page,
in the page select

OPERATING MODE: Access point mode
BAND(GHZ): 2.4

SSID: This is the SSID of the AP which will be created after configuration
is over

TX POWER: RF power for Tx. Set this value to “2” .

SECURITY ENABLE, PSK, SECURITY TYPE, ENCRYPTION TYPE: This is to
configure the security mode of the AP.

CHANNEL: Channel number at which the target AP is present. Value of
“0” is not allowed.

IP ADDRESS, SUBNET MASK, GATEWAY: These parameters set the IP
parameters of the AP.

BEACON INTERVAL and DTIM COUNT: This to set the beacon parameters
of the AP. For example, if beacon interval is 200 (msecs) and DTIM count
is 3, the DTIM interval would be 2x300=600 msecs.
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WiSeConnect Wireless Configuration
OPERATING MODE @ cClient @ Enterprise Client @ Access Point
BAND (GHZ) @ 24 ® 50
SSID anl122

TX POWER 2
CHANNEL 11 o-11
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IP ADDRESS 132 | .|188 |. 1 5
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IPV6 DHCP [0
IPV6 ADDRESS : : : : : : : i
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DTIM COUNT
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n
L]
[4]]
Q

EAP TLS [-]
INNER METHOD
USER IDENTITY

PASSWORD

FIRMWARE UPGRADE

Figure 28: Wireless Configuration page

Click on "SUBMIT” button. The information is sent to the module and stored in
its internal flash.

6) The module should now be power cycled or hard reset. It boots up
and then automatically creates and AP with the configured
parameters. The module will send out two responses to the Host, the
first corresponds to the internally given “Set IP Parameters”
command and the second to the “Join” command. Note that once the
module is restarted, no commands need to be given. The module
automatically and internally executes the commands to create an AP.
The stored configuration parameters can be retrieved using the
command “at+rsi_cfgget”. If the auto-connect feature needs to be
disabled, issue the command “at+rsi_cfgenable=0" to the module.
Refer to the PRM for more details on these commands.
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Flow 2: In this flow, the module is connected to an AP. A remote device
connects to the same AP and configures the module.

UJART '
Interface
\ RS9113 -—— - > .
PC (P) WiSeConnect {-‘""BC;ESS Paint
Module
4
!
/
/
Laptop(C)

Figure 29: Module Connected to Access Point

1) Connect a PC or Host to the module through the USB and power up
the module.

2) Configure the module to become client and connected to an AP by
issuing commands through PC (P).

3) Connect a Laptop (c) to the created AP. Open the URL
http://<Module’s IP address>/Index.htm in the Laptop. For
example, if the module was configured to have an IP of
192.168.100.1, then the URL is http://192.168.100.1/Index.htm.
Make sure the browser in the laptop does not have any proxies
enabled.

4) In the web page that opens, displaying the "Welcome to Redpine
Signals” and click on the "GO TO CONFIGURATION PAGE” (displaying
the web page in figure 28).

5) After that displaying the "WiSeConnect Wireless Configuration” page,
in the page select

OPERATING MODE: Access point mode
BAND(GHZ): 2.4

SSID: This is the SSID of the AP which will be created after configuration
is over

TX POWER: RF power for Tx. Set this value to “2” .
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SECURITY ENABLE, PSK, SECURITY TYPE, ENCRYPTION TYPE: This is to
configure the security mode of the AP.

CHANNEL: Channel number at which the target AP is present. Value of
“0” is not allowed.

IP ADDRESS, SUBNET MASK, GATEWAY: These parameters set the IP
parameters of the AP.

BEACON INTERVAL and DTIM COUNT: This to set the beacon parameters
of the AP. For example, if beacon interval is 200 (msecs) and DTIM count
is 3, the DTIM interval would be 2x300=600 msecs.

WiSeConnect Wireless Configuration

OPERATING MODE  © cClient @ Enterprise Client @ Access Point
BAND (GHZ) @ 24 ®© 50
SSID an123
TX POWER 2
CHANMNEL 11 0-11
SECURITY ENABLE 1
PSK

SECURITY TYPE ~© WPA  © WPA2
ENCRYPTION TYPE @ TKIP @ AES
IP VERSION 1Py E
DHCP [0
IP ADDRESS 192 |.|188 |. 1

SUBNET MASK 255 |.|255 |.|255 |.|O

GATEWAY 192 |.[168 |. 1
IPv6 DHCP [0

IPV6 ADDRESS H H H B B B B I
ROUTER ADDRESS
BEACON INTERVAL 200 20-1000
DTIM COUNT 3 1-255
EAP LS [-]

INNER METHOD
USER IDENTITY

PASSWORD

FIRMWARE UPGRADE

Figure 30: Wireless Configuration page

Click on “SUBMIT” button. The information is sent to the module and stored in
its internal flash.

6) The module should now be power cycled or hard reset. It boots up
and then automatically creates and AP with the configured
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parameters. The module will send out two responses to the Host, the
first corresponds to the internally given “Set IP Parameters”
command and the second to the “Join” command. Note that once the
module is restarted, no commands need to be given. The module
automatically and internally executes the commands to create an AP.
The stored configuration parameters can be retrieved using the
command “at+rsi_cfgget”. If the auto-connect feature needs to be
disabled, issue the command “at+rsi_cfgenable=0" to the module.
Refer to the PRM for more details on these commands.
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6 Appendix A: Headers on the EVB

6.1 Headers’ Pin Orientations

The figure below shows the pin orientations for the SDIO, SPI and GPIO
headers.

SPI/SDIO HEADER UART HEADER

6.2 SPI Header Pin Description

0 ® 0 ® =
® G ® G > G
® ® ® 6 D @
®® ®® =
®® ®® 2 &
13 I5 =

GPIO HEADER

J1

Figure 31: Headers’ Pin Orientations

The following table describes the pins of SPI header.

Pin
Number | Pin Name | Direction | Description
1 NC - This pin must be left open.
2 SPI_CS Input SPI slave select from host (active low)
3 GND - Ground
4 VDD - Supply voltage.
SPI_CLK Input Serial clock in from the host. The clock
5 can be up to 80 MHz
6 GND - Ground
7 SPI_MOSI Input SPI data input
8 SPI_MISO Output SPI data output
SPI_INTR Output Active high, level triggered interrupt,
used in SPI mode. The interrupt is
raised by the EVB to indicate there is
9 data to be read by the Host.
10 RESET Input Active Low Reset to RS9113 module.
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6.3 SDIO Header Pin Description
The following table describes the pins of SDIO header.

Pin
Number | Pin Name Direction Description
1 SDIO_DATA3 | Input/Output | pata3 of SDIO interface.
SDIO_CMD Input/Output| SDIO Mode: SDIO interface
2 command signal.
3 GND - Ground
4 VDD - Supply voltage.
5 SDIO_CLK Input This signal is SDIO clock.
6 GND - Ground
7 SDIO_DATAO | Input/Output | Data0 of SDIO interface.
8 SDIO_DATA1 | Input/Output | Datal of SDIO interface.
9 SDIO_DATA?2 | Input/Output | Data2 of SDIO interface.
RESET Input Active Low Reset to RS9113
module. This is not used with the
10 standard SDIO connector.

6.4 GPIO Header Pin Description

The following table describes the pins of SDIO header.

Pin
Number | Pin Name Direction Description

1 GND The GPIOs are generally not available for usage
2 GPIO_15 from the Host with the standard firmware. Please
3 GPIO 19 refer to the Software PRM for the pins that are
4 Gp10_16 supported or contact Redpine Signals in case you
5 GPIO 7 need to use them.

6 GND

7 GPIO_2

8 GPIO_17

9 GPIO_8

10 GPIO_18

11 GPIO_21

12 GPIO_12

13 GPIO_13

14 GPIO_14

15 GPIO_10

16 GPIO_9

17 NC

18 GPIO_11

3.3V Supply
19 Output
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20 | | |

Table 3: GPIO Header Pins
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7 Appendix B: Using the Bluetooth Manager

1) Once the Bluetooth modules have been installed using the
bt_insert.sh script as per the instructions in Section 4.4, hit the
“Windows"” button on the keyboard. You will see Bluetooth symbol at
the bottom-right corner of the screen, as show in the image below.

)
@
]
=
B
g
a2

Figure 32: Invoking Bluetooth Manager

2) This will open the Bluetooth Manager as shown in the image below.
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Bluetooth Devices

Adapter View Help

Q search

921008 0.008/5%7 982,008 0.008/5 W

Figure 33: Bluetooth Manager basic window

3) Click on Search to start inquiry.

Blustsath Devices

Adapter View Help

k
# Mot Connected

= CCORIRCFERAZ
- dinesh-0
= Cempuer
=== 00.0258.021520
lapt66b
Ceshtep
ECE5FIFQB4I2

# GT-N7100

Sarart pione
2ECCOLEES0AC

@ Rafa
B0SCES 40 CRsE

RSI
ES

QO 1EFF0LCB:08

Searching @ FAROOE 601 B 150 KB IRD 04 BT

4) Select particular device, like your smartphone, right click and select Pair
to pair with that device.
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Figure 35: Pairing with a Device

5) After successfully pairing with the device, right-click on the device and
select “Send a file” to send data to the device. You will be presented
with a dialog box to select the file that you wish to send.

Bluetooth Devices
Adapter  Dewice Yiew Help

Q search == ¢ Setp = SendFile
- X

Setup..
Wot Connected
B

ccosnrs9-2 | T
dinesh=0

= = Lempuker
000258021520

LaptB6
Dumbtop
ECSSFRFOB432

ﬂ GT-N7100
X bmark phone
28:CCD166:50:8C

Rafa
Q Coidr

BRFCESSS.CE6E

Rsl

lapsog
O 1E:37-01:£8:08

956,008 0.00 BT 411 KR 0008 G0
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8 Appendix C: WiSeConnect® Firmware Upgrade

This section describes the process for upgrading the firmware for
WiSeConnect® mode over UART.

1)

2)

3)

NOTE:

The firmware upgrade for n-Link mode is done automatically by the
driver that is provided as part of the release package. This is done by
comparing the version of the firmware present with the driver and the
one which is loaded.

The EVK is shipped with the WiSeConnect® firmware loaded. So a
firmware upgrade is not necessary unless there is a newer version
available or the EVB has been used in n-Link® mode and the user
wants to evaluate the EVB in WiSeConnect® mode after that.

The process explained below is for upgrading the WiSeConnect®
firmware over UART from a Windows PC using Teraterm. The
Software PRM gives details related to the process and commands to
be used to upgrade over other interfaces and MCU platforms.

1)

2)

3)

Download and install Teraterm from
http://en.sourceforge.jp/projects/ttssh2/releases/

Open Teraterm. You will be asked to setup a "New connection”. Click
Cancel.

In the Teraterm window, click on Setup -> Terminal... In the dialog
box that opens, change the following settings:

a. Under “New-line”, select "CR+LF” for Receive and Transmit

b. Enable “Local echo”.

c. Click OK
Tera Term: Terminal setup
Terminal size New-line
oK
58] X 40 Receive: CR4LF v
Term size = win size Transmit: CR+LF + Cancel
Auto window resize
Help
Terminal ID: VT100 v vl Local echo
Answerback: L] Auto switch (VT<->TEK)
Coding (receive) Coding (transmit)
UTF-8 v UTF-8 v
locale: american CodePage: 65001
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Figure 37: Terminal Settings for Teraterm

4) Next, click on Setup -> Serial port... In the dialog box that opens,
select the Baud Rate as 115200 and Click OK.

Tera Term: Serial port setup
0K
Baud rate: 115200 v
Data: 8 bit v Cancel
Parity: none v
Stop: 1 bit v Help
Flow control: none v

Transmit delay

0 msecichar 0 mseciline

Figure 38: Serial Port Settings for Teraterm

5) Connect the EVB to the PC using the USB-to-microUSB cable. Plug in
the cable into the micro-USB port labeled "UART” on the EVB.

6) Click on File -> New connection... In the dialog box that opens, select
the Serial option and select the COM Port from the drop-down menu.
It is COMS8 in the figure below. Click OK.

7) After the Automatic Baud Rate Detection timeout, you will see the
Welcome message and available options on the Teraterm screen.
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B COM8:115200baud - Tera TermvT ~ — = HEM
File Edit Setup Control Window Help

ELCOME T0O REDPINE SIGHNALS

BootLoader Uersion 1.5

Load Image-—I

Upgrade Image-I

Load Image-I1I
4 Upgrade Image-I1I

Set Image—-1 as Default
6t Set Image—II as Default

Enable GPIO Based Bypass Mode
B Disabhle GPIO Based Bypass Mode
A LOAD FIRMWARE (Image No : B-f>
B BURN FIRMWARE (Image No : @-f>
CHECK CRC <(Image No = @-f>
SWITCH DEFAULT IMAGE <Image No : @-f>

Figure 39: Module Startup Messages

8) Hit ‘2’ to select Firmware Upgradation mode. You will be requested to
send the Firmware file. For the EVK, the firmware file is present in the
USB drive in the RS9113.NBZ.WC.GEN.OSI.x.x.x\Firmware folder.
Here, x.X.X is the release version.
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= COMS8:115200baud - Tera Term VT - O

File Edit Setup Control Window Help

ELCOME TO REDPINE SIGNALS

BootLoader Version 1.5

Load Image-I

Upgrade Image-—I

Load Image-II
4 Upgrade Image—I1I

Set Image—1 as Default
p Set Image—Il as Default

Enable GPIO Based Bypass Mode
B Disable GPIO Based Bypass Mode
A LOAD FIRMWARE <{Image No : 8-f>
B BURN FIRMWARE <{Image No : O-f)

CHECK CRC (Image No : @8-f>

SWITCH DEFAULT IMAGE {Image No : @-f>

Send RS9113_WC_GENR_x_x_x_wlan.rps

Figure 40: Request for Firmware File

9) Click on File -> Transfer -> Kermit -> Send...

10)In the dialog box that opens, navigate to the
RS9113.NBZ.WC.GEN.OSI.x.x.x\Firmware folder and select the
RS9113.NBZ.WC.GEN.OSI.x.x.x.rps file.

11)A dialog box will open, showing the transfer of the firmware file.
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Tera Term: Kermit Kermit Send

Filename: IR$9113.NBZ.WC.GEN.(

Protocol: Kermit
Packet#: 170
Bytes transfered:
Elapsed time: 0:03 (2.89KBts)
0.7%
Cancel

Figure 41: Firmware Transfer Progress

12)Once the firmware is transmitted to the module successfully, the
module boots up with the updated firmware and requests the user to
select the option.

13)You may continue to use the EVB without disconnecting it. If you wish
to switch to Docklight from Teraterm, you can click on File ->
Disconnect in Teraterm, open Docklight and hit ‘F5’ to start the
communication from Docklight.
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9 Appendix D: Booting USB Drive on Windows 8 and
Later PCs

Starting with Windows 8, the BIOS uses the new UEFI system. This can
cause failures in booting from the USB drive provided as part of the EVK.
To get around this problem, please follow the steps below. The steps in
this section are explained for a Toshiba Kirabook. The process will be
similar for other Windows 8 PCs.

NOTE: It is recommended that the evaluation be done on PCs which have
the Legacy BIOS system installed. Please continue with the steps below
only if you are aware of what is being done because incorrect settings
might corrupt the Laptop’s settings and render it useless.

Once these changes are done, the original Windows 8 OS will not be
bootable until the changes are reverted.

1) While booting up the PC, press F2 to enter the BIOS setup screen.

- B ] T "
TOSHIBA T
Item Specific Help
m s System Time 16:53:40 '
<Tab> selects field. ]
System Date 01/19/2015 1
TOSHIBA Setup Utility
CPU Type Intel(R) Core(TM)
i5-4200U CPU
CPU Speed 1.60GHz
Main HDD/SSD TOSHIBA
THNSNJ256GMCT
- Security Total Memory Size 8192 MB
b System BIOS Version 1.40
PowerManagement EC Version 1.00

Language
dvanced English

Figure 42: BIOS Setup Screen

2) Scroll down to the “Security” section on the left part of the screen.
You will be shown an option called “Secure Boot”".
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TOSHIBA

| e "
| o
‘ m N BIOS Password

l User - Not Registered

rOSHIBA Setup Utility

| Supervisor - Not Registered

HDD/SSD Password
Mode

<wser only> [l ]
Security User - Not Registered

Secure Boot

<nabled> [l ]

Figure 43: Security Screen of BIOS

3) Disable the “Secure Boot” option.

TOSHIBA

BIOS Password
[ User

- Not Registered

[Supervisor - Not Registered

HDD/SSD Password
Mode

<User Only> -:

(User - Not Registered

]

Secure Boot

Figure 44: Disable “Secure Boot”

4) Next, scroll down to the "Advanced” section on the left part of the
screen.
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TOSHIBA

Execute-Disable Bit Capability

<Available>'-:
T-xonly> 1R
Disabled> [N
<Disabled> [l

<nabled> [l ]
Rapid Start Entry after

|2’ hours Vv

Virtualization Technology
Intel(R) AT
Intel(R) AT Suspend

Intel(R) Rapid Start Technology

Advanced
Beep Sound

| Medium
Sleep and Charge
D

System ON CDP Charge

5) Scroll down to the “"System Configuration” option under “Advanced”
and hit Enter.

TOSHIBA

USB Legacy Emulation

I »Change Boot Order

»System Configuration

Figure 46: System Configuration under Advanced

6) In the new screen, you will see an option labeled, "Boot Mode” and it
will be in "UEFI Boot” mode.
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TOSHIBA

System Configuration

Wireless LAN

Bluetooth

<enabled> [l
<enabled> [l ]
<€nabled> [l

Web Camera
SD Host Controller
Internal USB3.0 Controller

Memory Performance Mode

Boot Mode

Figure 47: System Configuration

7) Select the "Boot Mode"” option and hit Enter to disable UEFI Boot and
enable CSM Boot - this is the legacy booting option of BIOS.

R (IR Tage pen |  item Spe

System Configuration

TOSHIBA Setup Utiity Wirelons LAN

£ naviea- [l
s naviea- [l
Web Camera . E
S0 Host Controfler Enablecs E

Bluetooth

Internal USHI 0 Controller
+ naviea- [l

Moemory Performance Mode
£ naviea> [l

Figure 48: Disable UEFI Boot

8) Select the Exit option and save the changes before exiting.

9) Once these changes are done, the original Windows 8 OS will not be
bootable until the changes are reverted. To revert changes, enable
UEFI Boot first and then enable Secure Boot (in that order).

Xk kK%
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Revision History

Version Date Changes
No.
2.0 January 2015 | Initial Version for Version 2.0 of the EVB
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